Getting started in RHEcourse

Here are the instructions for how to add a course, edit it, add students, and track student progress.
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Adding a Course

When you login you will be taken to your instructor dashboard. From the instructor dashboard you can
see any existing courses you have created. From this page you have the option to add a new course by
clicking either the “add new course” or “add new course from template” button.
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Selecting “add new course” will allow you to create your own course from scratch. If you select the “add
new course from template” button, you will see a selection of the available template courses for you to
use. If you click the “preview course template” button you will be able to view the course contents in a

new window.

Curriculum Course Templates

Welcome to RHEcourse! Click on the preview button to see course contents before adding the course to your dashboard. To add a course to your
dashboard simply click the “copy course template” button. You will then be able to add students from your dashboard. Each template course is
customizable for more detailed information on how to customize a course visit our FAQ's page.

AVAILABLE COURSES -

The Framework: Counseling for EXPLAINED: Abortion Research and Ryan Residency Training Program
Patient-Centered Abortion Care Policy Curriculum

COPY COURSE TEMPLATE COPY COURSE TEMPLATE COPY COURSE TEMPLATE

Abortion Course: Quality Care and Early Pregnancy Loss
Public Health Implications

After determining which course you’d like to add, click the “copy course template” button for that
course and it will automatically take you to the course editor. Your new course will have your name
listed at the end of the title.

PREVIEW COURSE TEMPLATE

LARC Insertion and Removal Course

Editing a Course

The next step is to edit the course. In the course editor you have the option to: change the course title,
make the course active, add a due date, and change (add/delete/update) any preset content in the
template.

Once in the course editor, scroll down until you see the “Status” drop-down menu.

Select the status option you want:
e Active: The course is active and you can add students.
e Inactive: The course is inactive and you cannot add students, but you can add any necessary
course materials. When making a new course, this is the default status.
e Complete: The course is completed, so learners cannot take quizzes or get credit for any
progress made after completion of the course, but enrolled students can still review course
materials.



ACAUEINY 01 MEWCHIE S SIX UHNENSIONS O NEAIL Care quality. LIS INEnuondl approdaci requires Uie provision 01 Care tdt 1s respecuul ol dana
responsive to individual patient preferences, needs, and values and empowers people to take charge of their own health.

Status
Active L
Complete
Template

Due Date

a»

Directly below the status menu is the “Due Date”. Clicking on this will open a calendar. Select the latest

date students can submit materials for the course. You are not required to set a due date if you do not
want one.

Status
Active )
Due Date

Mar ¥ 2019 ¢

Today Close
un-site

-

Adding Pre/Post Tests

Add any pre/post tests you’d like. Tests can be pulled from prebuilt “onsite” quizzes or you can link to
your own “offsite” test, hosted on Qualtrics or Google Forms for example. Off-site test scores will not be
available for reporting through RHEcourse.



Adding Units & Modules

2 Content .
Content Title *

Content *
Visual  Text
File v Edit v View v Inserty Format » Tools v Table
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You can add units to a course by clicking the “Add Unit” button. Units are broader topic areas containing
multiple modules. For example, “Counseling” is a Unit in the LARC Insertion and Removal Course, and
“LARC Insertion: Contraceptive Counseling with Shared Decision Making Framework” is a module,
containing a specific resource, within that Unit.

LARC Insertion and Counseling
Removal Course LARC INSERTION: CONTRACEPTIVE COUNSELING WITH SHARED DECISION MAKING
FRAMEWORK
Overview
LARC Overview » @
Informed Consent >
Counseling -

LARC Insertion: Contraceptive Counseling with
D icH MUking PR Contraceptive Counseling with
Initiation of Shared Decision Making Process Shared Decision M aking Framework

Responding to Patient Concerns

Patient Requesting Implant Removal

Shared Decision Making Using a Decision Aid

IUD Insertion >

PREVIOUS
1UD Advanced Topics » m

After adding a new unit, you will add a title to the unit and can add modules by selecting the “Add
Module” button.



Content *
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Required?
Completion of this module is required for completion of the course

UPDATE COURSE

Visual  Text

Resource

Content

Quiz

ADD MODULE

There are three different types of modules available to add: Resource, Content, and Quiz. Resources are
directly pulled from the Innovating Education website. These can be video lectures, slide sets, or any
other resource that can be found at innovating-education.org. Content modules are for your custom
content where you can add your own text, links, media (including PDFs), and videos. Quiz modules are

for adding premade quizzes from the system.

Adding a Resource Module

When adding a Resource module, the “taxonomy” function serves as a filter to show the resources from
innovating-education.org that relate to each topic. Once a topic is selected, you can then search for
specific resources within those filtered results by using the “search” bar, or you can browse through all

of the results for that topic on the left.

4 Resource
Resource *
Search..

A Practical Guide for Establishing a Jail
Rotation

Abortion Access in South Africa

Abortion After the First Trimester

gga o

Abortion after the First Trimester

Required?
Completion of this module is required for completion of the course

uroarecounst |  viw |

Abortion Access

- Health Disparities

- TRAP Laws

Abortion Complications
Abortion Training

- Career Planning and Support
- Partial Participation
Blog

Contraception
Counseling

Course Documents
CoviD-19

Curated Resources
D&E

Early Pregnancy Loss
Explained Series
Fertility Awareness Based Methods
First-trimester Abortion
General

- Clinical Teaching
Global Perspectives

- Unsafe Abortion
Health Equity



The other way to find a resource is to use the “Search” bar without the taxonomy filter, to locate a
specific resource. Resources can include video lectures, slide sets, lesson plans, etc. To preview a
resource, select “View” and a popup screen will display the resource/video for you to review. When you
are finished previewing the resource click the “x” in the top right corner of the popup screen.

To select a resource for your module, simply click the “+” button next to the name of the desired
resource and it will populate in the column to the right. You can only add one resource per module. To
add another resource or additional content, click the “Add module” button again and repeat the steps
above.

4 Resource -
Resource *

Search.. Select taxonomy

A Practical Guide for Establishing a Jail
+
Rotation m .

Abortion Access in South Africa m
Abortion After the First Trimester m
Abortion after the First Trimester m n

Required?
Completion of this module s required for completion of the course
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ADD MODULE
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Abortion Access in South Africa

Abortion After the First Trimester n

Abortion after the First Trimester m
Required?

Completion of this module is required for completion of the course

ADD UNIT

ADD MODULE

UPDATE COURSE m

The new module will automatically be marked as “required” for course completion. If you'd like this
module to be supplemental or optional, meaning it will not be tracked as part of course progress or



completion, you should uncheck the box next to “Completion of this module is required for completion

of the course”.

4 Resource

Resource *

Search...

A Practical Guide for Establishing a Jail
Rotation

Abortion Access in South Africa
Abortion After the First Trimester

Abortion after the First Trimester
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Completion of this module is required for completion of the course

UPDATE COURSE | )

ADD MODULE

ADD UNIT

After you've completed your changes, scroll down to the very bottom or top of the page and click the
“Update Course” button. That will save your changes. You can then click the “View” button to see what

your course will look like to learners. Required modules will be marked with a

title. It will look something like this.

Structures & Self:
Advancing Equity and
Justice in Sexual and
Reproductive Healthcare -
innovating_education

Overview

Pre-Assessment

Learning Objectives -
Learning Objectives
Pillar I: Own Our Legacy -

% Own Our Legacy

* Personal Reflection Questions

Pillar II: Recognize Structures of »
Oppression

Pillar III: Check Yourself »
Pillar IV: Take Action »

Post-Assessment

“ugn

next to the module

BACK TO DASHBOARD

Learning Objectives
LEARNING OBJECTIVES

+ Learners will become familiar with historical context and implications for disparities in
sexual and reproductive health. This video will review how the history of oppression,
contributes to current structures disparities.

Learners will explore how the structures of power and oppression manifest within
healthcare systems and impact sexual and reproductive health outcomes.

Learners will identify implicit bias, privilege, and fragility in regarding patient
interactions, their relationship to structures of oppression, and practices for self-
reflection and self-care.

After learners have recognized their privilege, they will identify ways to center a justice
framework and structural analysis as a tool to promote optimal health outcomes.

PREVIOUS | m



Adding a Content Module

Content modules are modules that can include text, links, images, and PDFs that are not existing

resources on the Innovating Education site. You can use this space for supplemental readings, resources,
etc.

Adding a PDF/Image

To add your own media (PDFs, images, etc) you will need to add a content block. Within the new block
you will select “Insert” and scroll down to select “Add Media”.

5 Content

Content Title
Content *
Visual  Text
File v Edit » View « Insert o | Format v Tools v Table »
B I U € =< P Insert/editlink & =
BE Media
ER Table

0 Special character

— Haorizontal line

&+, Nonbreaking space

[] Anchor

Date/time

I Insent Read More tag

W Page break

Required?

Completion of this module is required for completion of the course

ADD MODULE

This will open a page to upload the media you’d like to insert or to choose from your previously

uploaded media in your Media Library. Upload the file you’d like to insert/select it from your library and
edit the attachment details (title, link, size, etc) in the panel to the right.



Actions Add Media

Add Media Upload Files  Media Library
Create Gallery

Create Audio Playlist

Create Video Playlist

Insert from URL

Drop files to upload

or

Select Files

Maximum upload file size: 64 MB.

Actions Add Media x

Add Media Upload Files Media Library

Create Gallery Filter Media Search %

Create Audio Playlist Al media kems &) [ AN dates Getting-started-in-RHEcourse-1.pdf
May 6, 2020

M8

Delete Permanently

Create Video Playlist

Insert from URL

Title | Getting started in RHEcoL
Getting-started- Stnbiidntessiabinntind

- in-RHEcourse-
1pdf

Caption

Description
Copy Link | https:/fwww.innovating-e«
ATTACHMENT DISPLAY SETTINGS

LinkTo | Media File

URL | https:/fwww.innovating-et

size | Medium-232x300 §

|m|rem selected E Insert into post
ear

Make sure the file you’d like to insert is selected and click “Insert into post”. If you have added a PDF the
PDF will be hyperlinked and will open in a new URL. If you added an image, the image will show directly
in the module.



5 Content

Content Title *

Adding a PDF
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File v Edit v View v Insert ¥y Format v Tools v Table v
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Getting started in RHEcourse Inserted PDF

Required?

Completion of this module is required for completion of the course

Inserted Image

Visual  Text

ADD MODULE

To ensure that the PDF loads in a new tab you will need to click on the link, click the pencil button to
edit, and then click the gear to edit the link settings. From this page click “Open link in new tab” and

update.

Content *

File v+ Edit v View v Insert + Format » Tools v Table »
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Getting started in RHEcourse

innovating-education.org/.. /Getting-started-in-RHEcourse-1.pd @ 2

Content *

File v Edit+ View » Insert+ Format~ Tools » Table »

o c[e
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Getting started in RHEcourse

Insert/edit link

Enter the destination URL

URL  https://www.innovating-education.org/cms/assets/L

Link Text Getting started in RHEcourse
Open link in a new tab

5/2019/08/Getting-started-in-RHEcourse-1.pdf E‘ fe

To edit an image or other inserted media, simply hover over or click on the image and click the pencil to
edit. The image details will open and you can edit the image size, title, etc. You can also have the image
link to a different page by editing the “link to” portion of the image’s details.



Image Details

Alternative Text

Describe the purpose of the image. Leave empty if the image
is purely decorative.

Caption

DISPLAY SETTINGS

Align[ Left ‘ Center Right I None

Size | Medium - 300 x 199 3|

Link To | Media File

URL | https://www. I 2019/08/Sc

ADVANCED OPTIONS &

Image Title Attribute
Image CSS Class

Open link in a new tab

Link Rel

The new module will automatically be marked as “required” for course completion. If you'd like this
module to be supplemental or optional, meaning it will not be tracked as part of course progress or
completion, you should uncheck the box next to “Completion of this module is required for completion
of the course”.

After you've completed your changes, scroll down to the very bottom or top of the page and click the
“Update Course” button. That will save your changes. You can then click the “View” button to see what
your course will look like to learners. Required modules will be marked with a “*” next to the module

title. It will look something like this.

Structures & Self: Learning Objectives

Advancing Equity and LEARNING OBJECTIVES

Justice in Sexual and

Reproductive Healthcare - + Learners will become familiar with historical context and implications for disparities in
in novati ng_ed ucation sexual and reproductive health. This video will review how the history of oppression,

contributes to current structures disparities.

Overview » Learners will explore how the structures of power and oppression manifest within

healthcare systems and impact sexual and reproductive health outcomes.
Pre-Assessment

Learners will identify implicit bias, privilege, and fragility in regarding patient
Learning Objectives - interactions, their relationship to structures of oppression, and practices for self-

reflection and self-care.
Learning Objectives

After learners have recognized their privilege, they will identify ways to center a justice
Pillar I: Own Our Legacy 4 framework and structural analysis as a tool to promote optimal health outcomes.

* Own Our Legacy

#* Personal Reflection Questions

2 5 PREVIOUS
Pillar II: Recognize Structures of » m

Oppression
Pillar I11: Check Yourself »
Pillar IV: Take Action »

Post-Assessment



Adding Learners to Your Course

Go back to your dashboard by clicking the “Back to Dashboard” button. If the course has been properly
updated the status and due date should now be changed on your dashboard.

The last step is inviting students. Click the gray pencil box button, under the student column, for the
course you’d like to invite students to.

Logged In As Amanda Sawyer View Dashboard Edit Profile Logout

‘.. innovating edUcation A project of the Bixby Center for Global Reproductive Health
PN in reproductive health
Instructor Dashboard

STATUS TITLE DUE DATE STUDENTS

The Framework: Counseling for Patient-Centered - E -
ACTIVE Sbirkion Cars+ Loy Mar 23, 2019 o(& # EDIT COPY @ DELETE
ADD NEW COURSE ADD NEW COURSE FROM TEMPLATE

odo innovating education
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You will then be prompted to add the student’s email. If this is their first time using RHEcourse, you will
also be prompted to add their first and last name. To add multiple students at once click “add multiple
students at once” under the invite a student email box. If you are inviting more than one student you
can click the gray “+” at the end of any row to add an additional student input line. Once you’ve added
the email address and names of all of your students click “invite these students”.



BACK TO COURSE BACK TO DASHBOARD

Students in The Framework: Counseling for Patient-Centered
Abortion Care - Copy

Invite Students

[ Email Address ‘ First Name ‘ Last Name } o
[ Email Address | First Name | Last Name ] -+
[ Email Address ‘ First Name ‘ Last Name ] oo

INVITE THESE STUDENTS

D Add students individually

There are no students in this course yet. Invite some!

The students will get an email notification to register for your course, similar to the one you received to
register for RHEcourse. They will need to register within ONE WEEK of receiving the email or their link
will expire, and you will need to re-invite them (see below). Once they register, the number in the
student column will automatically update. You can invite additional students to the course at any time
as long as the course due date has not passed.

Re-inviting Learners
You can resend an invitation to learners from your dashboard by clicking the gray pencil box next to
course they’re enrolled in. You can then click the gray pencil box next to the learners you wish to resend

the invitation to (their status will say “invited” instead of “active”). You can then select “resend invite”.

Learners will need to click the link in the invitation email within a week or it will expire again.

Do you want to mark this student as inactive, or remove them from the course
entirely?

RESEND MARK AS REMOVE
INVITE INACTIVE COMPLETELY




Invite email has been resent.

Removing Learners from Your Course

This is also the page where you can remove learners from a course. To remove learners, simply click on
the gray pencil next to the learner’s name. You will be given options to mark the learner as inactive,
archive the learner, or remove them completely. Select “remove completely”.

‘.‘ | nn OVat ‘ n g ed U Catlo n A project of the Bixby Center for Global Reproductive Health
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BACK TO COURSE BACK TO DASHBOARD

Students in LARC Insertion and Removal Course - Cassandra
Carver

Invite a Student [ Email Address m

52 Add multiple students at once

STATUS FIRST NAME LAST NAME EMAIL COURSE PROGRESS PRETEST POSTTEST
ACTIVE [#  Cassandra Carver 0/25
AcTIvE (&8  Stefanie Boltz 0/25

EXPORT STUDENT PROGRESS ARCHIVE ALL STUDENTS



Do you want to mark this student as inactive, or remove them from the course
entirely?

m MARK AS INACTIVE m REMOVE COMPLETELY

Monitoring Learner Progress and Exporting Course Performance

After you’'ve successfully invited students to your course, you can monitor their progress from the same
page used to invite students (accessed by clicking the gray pencil box next to the desired course). You
can export student results to a CSV file by clicking “Export Student Progress”. You will be able to find
the exported CSV file in your Downloads folder.

Students in The Framework: Counseling for Patient-Centered
Abortion Care - Cassandra Carver

Invite a Student { Email Address m

£ Add multiple students at once

STATUS FIRST NAME LAST NAME EMAIL COURSE PROGRESS PRETEST POSTTEST

AcTIVE (& Cassandra Carver casscarver3@gmail.com 8/9 Completed B (83%)

EXPORT STUDENT PROGRESS ) ARCHIVE ALL STUDENTS



Your CSV export will look something like this. Modules that have been completed by learners will be
marked “complete” and incomplete modules will be left blank. Other learner information, including quiz
and pre/post test scores are also listed.

AutoSave @ H HEF 9+ = s course-students-the-framework-counseling-for-patient-centered-abortion-care-cassandra-carver-20200625-190932
Home  Insert Draw Page Layout Formulas Data Review View Q Tell me 1 Share [J Comments
A Calibri (Body) 2 AN E=Z ®e | Bwestms General =i @ . v | Bwenv |y~ A /O . 5
M~ B Delete v+ [T~
Paste v | B~ v A = = == H 5 v o &0 01 Conditional Format  Cell - Sort& Find&  ldeas
=1 B Iy m S A === = 5 marga & conter $v% 9 W 0 Formatting as Table  Styles [Efl Format v 3~ Fiter Select
© Possible Data Loss Some features might be lost if you save this workbook in the comma-delimited (.csv) format. To preserve these features, save t in an Excel file format. Save As...
Al s fx Userip v
A [ c P [ G H 1 X i [ N o 3
1 [Userio 1 142
2 [Status active
3 |First Name Cassandra
4 |Last Name Carver
5 |Email
6 Enrollment Date

7 8 Required Modules Complete
& |Total Required Modules

4/20/20 16:59
8

9

9 |% Required Modules Complete 8
10 Pre-Test Score

11 1.1, Course Objectives (Content)* Complete

12 |2.1. Decision Counseling for Positive Pregnancy Test Results*

13 3.1 The Framework: The Patient Has the Answer* Complete

14 3.2, The Framework: Liberation® Complete

15 3.3, The Framework: Not A Failure® Complete

16 |34. The Framework: The Approach® Complete

17 |4.1. Case Study (Content]* Complete

18 |42 Self-Reflection (Content)* Complete

19 5.1 Readings (Content]* Complete

20 |Post-Test Score 8

21

Reviewing Quiz Results

From this page you can also review learner quiz performance and answers by clicking on the button with
the graph (located to the right of the course progress bar). This will open a quiz review for pre/post
assessments as well as any additional quizzes added to the course. Simply click each quiz title to open
the dropdown of results for that quiz/assessment.

The Framework: Counseling for Patient-Centered Abortion Care -
Cassandra Carver: Results

Pre-Assessment

Post-Assessment

=

+ Who has the answer when it comes to making about a pl

@ The patient v
O Someone other than the patient

v What are the 3 steps of the approach for counseling for positive pregnancy test results?

@ Listen v

@ Do Not Assume

@ Self-Reflect

O Give Your Opinion

of the

+ Which of the step?

g is NOT a

@ Asking yes or no questions v
O Silence

O Being open and curious about the patient’s process
O Asking open-ended questions

 True or False: It is fine to assume the patient understands what a “positive” or “negative” pregnancy test means.

O True
® False v

for

 Which of the g are pti a patient's



Archiving Learners

If you would like to archive your students, click the “archive all students” button. Archived students will
still have access to the course materials for their review, but cannot take quizzes or earn additional
marks toward completion. This feature allows instructors to keep a course open and have both active
and inactive students without needing to make a new course for each new cohort of learners.

¥ innovating education R
PN in reproductive health

BACK TO COURSE BACK TO DASHBOARD

Students in The Framework: Counseling for Patient-Centered
Abortion Care - Cassandra Carver

£52 Add multiple students at once

Invite a Student

STATUS FIRST NAME LAST NAME EMAIL COURSE PROGRESS PRETEST POSTTEST

AcTive (#8  Cassandra Carver 89 _
EXPORT STUDENT LIST [l ARCHIVE ALL STUDENTS



FAQs

Instructors

Can | add another instructor to help me manage my course?

o RHEcourse does not offer the option to have multiple instructors administer a course. If
you’d like to have more than one instructor for your course, you can share your login
information to give the other instructor access to the course. You also have the option
to choose to register with an email you both have access to, and/or you can set a
password you’re comfortable sharing.

The pre-built quizzes don’t fit my needs. Can | add my own quizzes?
o Yes! RHEcourse gives you the option to link to your own “off-site” quiz. Find directions
here.

The registration link for my learners expired. What should | do?
o You can re-send their invitation email by following the directions here.

What should | do if I’'m still having trouble or my issue isn’t mentioned here?
o Ifyou need further assistance please contact us at info@innovating-education.org.

Learners

Does RHEcourse save my progress?
o Some of it! RHEcourse does not save progress on partially completed modules or
partially viewed videos, but once you have completed a module and have a green check
mark next to it, your progress to that point has been saved.

What does the green check mark mean?
o Once you have completed a module (watched the video, read the content, completed
the quiz, etc) a green check mark will appear next to the module.

What does the * mean?
o This symbol represents modules that are deemed “required” for course completion.
Modules without this symbol are considered “supplemental”. Learners can complete
the course without completing supplemental modules.

The link | got to register for an account has expired/is invalid. What should | do?

o Ifyou're getting an error message after clicking the registration link sent in your
invitation email it means your link has expired. Links will remain active only for 7 days
after the invitation email is sent. To request a new link please email us at
info@innovating-education.org.

I've watched the video, why don’t | have a green check mark?

o To ensure you get credit for completing each module, make sure you watch the video in
its entirety before exiting or refreshing the page. Completion of the module will be
shown by a green check mark next to the resource in the left side bar. You can
complete the modules and watch the videos at your own pace, but RHEcourse will only


mailto:info@innovating-education.org
mailto:info@innovating-education.org

save completed modules. If you watch a portion of a video and leave before it's
complete you will need to watch the full video again in its entirety for it to be marked as
complete. RHEcourse does not save progress on partially completed modules or
partially viewed videos.

- What should I do if I'm still having trouble or my issue isn’t mentioned here?
o If you need further assistance please contact us at info@innovating-education.org.
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